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Was? Wozu? Warum?

« Endnote ist ein kostenpflichtiges Literaturverwaltungsprogramm, das Sie
hier bestellen kdnnen

« Sie kdnnen Dokumente jeglicher Art sammeln, ordnen und verwalten
« Generiert eine Literaturliste im entsprechend eingestellten Zitierstil
« Unter diesen Betriebssystemen nutzbar: Windows, MacOS

« Synchronisierung von Dateien und Daten -> ermdglicht Sicherung auf
einem Server und gemeinsames Arbeiten

« Gruppenfunktion fur die Arbeit im Team

« Sie promovieren an der UMG? Dann benétigen Sie den UMG-Zitierstil ftr
Endnote

@ GEORG-AUGUST-UNIVERSITAT Endnote-Selbstlernkurs NIEDERSACHSISCHE STAATS- UND | q lJ q
y_K GOTTINGEN UNIVERSITATSBIBLIOTHEK GOTTINGEN -~ L


https://www.endnote.de/
https://www.sub.uni-goettingen.de/-UgkN6

Unterstutzung:

Online:
 Endnote-Tutorial-Kanal auf youtube

In der Endnote-Datenbank:
 Menupunkt ,,Help“ -> Endnote Training Portal

OpenClipart-Vectors- CCO

Aul3erdem:
e Technischer Support Uber Alfasoft
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https://www.youtube.com/user/EndNoteTraining
https://support.alfasoft.com/hc/de/categories/360000111937-EndNote
https://pixabay.com/de/hilfe-button-rot-notfall-153094/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Das Datenbankfenster

Linke Seite: ,My Library“: zeigt Untergruppen von Referenzen, dient zum Sortieren und
Organisieren

Mitte: zeigt bibliographische Daten in Spalten an

Rechte Seite: Metadatenbereich: Wahl zwischen Detailansicht einer Referenz, einer Vorschau
oder der Bearbeitung einer angehangten pdf-Datei
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Bevor Sie starten, tragen Sie unter dem MenUpunkt ,Edit* -> ,Preferences” -> ,Find Full Text“ bei ,open url
path“ den gbv-link ein:
https://sfx-49gbv.hosted.exlibrisgroup.com/sfx_sub
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https://creativecommons.org/licenses/by-nc-nd/3.0/

Los geht's:

U b U n g 1 - OpenCIipart-Vectors- CCOo

- Ubernehmen Sie mit den Suchwortern Demenz und Alter einige Treffer (11-
20) aus dem GUK in |hre Endnote-Datenbank

« Legen Sie fur diese Referenzen eine Custom Group an und sortieren die
Referenzen dort hinein

« Vergeben Sie fur einen Titel ein neues Schlagwort Ihrer Wahl

* Legen Sie eine Smart Group an, die auf der Suchanfrage basiert , Titel von
Gerald Huther aus dem Jahr 2015"

« Starten Sie eine Suchanfrage mit den Suchwortern Huther, Gerald im GUK,
ubernehmen Sie Treffer 1-30 in Inre Endnote-Datenbank und beobachten
Sie, was passiert
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https://pixabay.com/de/eule-tier-vogel-computer-lustig-158414/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Losungen Ubung 1:

« Starten Sie den GUK, geben Sie Demenz und Alter ein und gehen auf S. 2 der Trefferliste.(Tipp:
Nutzen Sie Firefox als Browser!) Klicken Sie links im Feld auf Speichern und wéhlen Sie unter
Format Literaturverwaltung Endnote aus -> Speichern

 Wabhlen Sie in der Endnote-Datenbank den Menipunkt Groups -> Create Group und vergeben
einen Namen, z.B. Alterskrankheiten

« Markieren Sie alle Referenzen im mittleren Fenster. (Dazu eine Referenz anklicken, den
MenUpunkt edit auswéhlen und select all anklicken). Mit drag and drop lassen sich die
Referenzen in die neue Custom Group verschieben (alternativ: Referenzen markieren, rechte
Maustaste -> Add References To -> neu angelegte Gruppe)

« Markieren Sie mit der linken Maustaste einen beliebigen Titel. Im rechten Feld sehen Sie unter
dem Reiter Edit die Datenbankfelder, die Endnote mit den dokumentbeschreibenden Angaben
(Metadaten) belegt. Scrollen Sie zum Feld Keywords, klicken hinter das letzte Schlagwort und
dricken die Return-Taste. Vergeben Sie ein Schlagwort Ihrer Wahl (z.B. Demenztherapie) und
speichern Sie (strg + S)

Selbst eingegebene Schlagworter, Kommentare etc. konnen tber die Suchleiste in Endnote auch
wieder gesucht werden!

*  Menu Groups -> Create Smart Group -> Name Huther 2015

1.Suchfeld Autor Hiuther, Gerald, 2.Suchfeld Year -> Textfeld 2015 -> Create

Im GUK Suchanfrage Huther, Gerald starten und Treffer 1-30 in Endnote Gbernehmen
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Weiter geht's:

U.S. National Library of Medicine

Ubung 2:

* Suchen Sie in der Datenbank PubMed alle Artikel von Ulrich Sax und
ubernehmen Sie sie in Ihre Endnote-Datenbank

« Starten Sie mit Endnote die Volltextsuche

« Schauen Sie sich ein pdf an und setzen einen Kommentar

« Gehen Sie direkt mit Endnote in die Datenbank PubMed und starten eine
Suchanfrage mit Turner Syndrome Children

« Ubernehmen Sie die ersten 10 Referenzen in lhre Endnote-Datenbank

* In der ,Pharmazeutischen Zeitung Online® hat Annette Mende einen Artikel
zu Gicht und Fructose als moglichem Ausloser verfasst. Fligen Sie diese
Webseite/diesen Artikel Ihrem Projekt hinzu
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https://www.ncbi.nlm.nih.gov/pubmed/

Losungen Ubung 2:

«  Zuerst: Import Filter aktivieren! Menupunkt Tools -> Import Filters -> Open Filter Manager
Mit einem Klick ins Kastchen den Filter PubMed NLM aktivieren

 Gehen Sie Uber das DBIS Infosystem (Homepage SUB -> Suchleiste -> DBIS) in die Datenbank
PubMed und geben Sie Sax, Ulrich ein. Klicken Sie auf send to, wahlen Citation Manager und die
Option all results aus. Dann klicken Sie auf -> Create File

«  Markieren Sie einige der importierten Referenzen, klicken mit der rechten Maustaste darauf und
wabhlen find full text

-  Offnen Sie eins der gefundenen PDF‘s (im rechten Fenster unter dem Reiter Summary) und
klicken Sie das Symbol markup/annotation an. Damit 6ffnen Sie die Bearbeitungsfunktionen fir
das PDF. Sie kdnnen jetzt z.B. einen Kommentar setzen: klicken Sie das Symbol sticky note an,
klicken in den Text, wo der Kommentar hin soll und doppelklicken Sie. -> im Eingabefeld
Kommentar setzen, speichern

«  Zuerst: Connection File aktivieren! Mentpunkt Tools -> Connection File -> Open Connection
Manager -> mit einen Klick ins Kastchen PubMed NLM aktivieren

* Wabhlen Sie bei Endnote unter Online Search Mode PubMed aus. Starten Sie eine Suchanfrage
mit any fields und den Suchwdrtern Turner Syndrome Children. Markieren Sie die ersten 5 Treffer
und klicken Sie auf das +-Symbol oben rechts. Damit importieren Sie die Treffer in Ihr Endnote.
Sie finden sie unter der Ablage recently added.
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Losungen Ubung 2 - Fortsetzung

«  Starten Sie mit Google eine Suchanfrage mit Mende Gicht Fructose und wéhlen den passenden

Treffer aus
Klicken Sie in Endnote den Button New Reference in der Symbolleiste und geben in der

Eingabemaske alles ein, was Sie der Website entnehmen kénnen (vor allem url! Aul3erdem
empfiehlt es sich, auf Dokumenttyp journal article umzustellen um die Felder entsprechend

auszuftllen)
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Fast geschafft!

Ubung 3:

« Schreiben Sie ein paar Satze in Word

« FlUgen Sie an mehreren beliebigen Textstellen Zitationen ein (Buch,
Zeitschriftenartikel)

« Wechseln Sie den Zitationsstil und beobachten die Veranderungen

« Lassen Sie sich von Endnote ein Literaturverzeichnis erstellen

3dman_eu - CCO
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https://pixabay.com/de/stift-kuli-schreiben-1020006/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Losungen Ubung 3

mcmurryjulie - CCO

«  Schreiben Sie ein paar Satze in Word

« Stellen Sie den Curser an die Textstelle, wo die erste Zitation eingefligt werden soll und klicken
Insert Citation

« Wabhlen Sie sich in der Suchmaske Ihre Referenz aus, die zitiert werden soll und fligen Sie sie in
Ihr Word-Dokument ein

« Flgen Sie ein weiteres Zitat in Ihren Text ein und nutzen jetzt den Button Go to Endnote in Word.
So kommen Sie in die Vollansicht Ihrer Endnote-Datenbank und kdnnen nun eine Referenz
auswahlen. Uber die Anfiihrungszeichen (Symbol oben rechts tiber der Trefferliste) wird die
Zitation in Ihr Word-Dokument eingeflgt.

Das Literaturverzeichnis wird automatisch erstellt und immer aktualisiert!
 Wechseln Sie den Zitationsstil, indem Sie einen anderen in der Style-Suchleiste auswahlen

* Markieren Sie beliebige Referenzen in Ihrer Endnote-Datenbank und klicken mit der rechten
Maustaste darauf

« Wabhlen Sie Copy formatted Reference und fligen es in ein leeres Word-Dokument ein -> so
kbnnen Sie mit Endnote eine Literaturliste mit beliebig ausgewéahlten Referenzen erstellen
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https://pixabay.com/de/lims-laborinformations-1604450/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

« ¥
AN
Termlists — das Besondere ‘[\

-
3dman_eu - CCO

« Termlists: ,Begriffslisten”, dienen zur Speicherung von Eintragen wie Keywords,
Autorennamen und Zeitschriftentiteln

— Mit der journal termlist wird im Literaturverzeichnis — je nach Zitierstil - der abgekirzte
Zeitschriftentitel ausgegeben anstelle des ausgeschriebenen

— Ergéanzen sich automatisch, sobald ein neuer Autorenname, Keyword oder Zeitschriftentitel
in die Datenbank eingegeben wird

— Termlists enthalten alle Autorennamen, Keywords und Zeitschriftentitel, die in der Endnote-
Datenbank vorkommen

« Erganzung der Journal Term List:
— Menlt library -> define term list -> termlist journals auswahlen -> import list anklicken ->
medical auswahlen -> Offnen -> mit dem Reiter Terms Ansicht der aktualisierten Journal
Termlist (2 Spalten mit Titeln und AbkUrzungen)
— Je nachdem, welcher Output Style nachher gewahlt wird, gibt Endnote entweder den
ausgeschriebenen Titel oder die Abkirzung einer Zeitschrift im Literaturverzeichnis aus
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https://pixabay.com/de/idee-antwort-erleuchtung-klugheit-1019808/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Die Online-Version: Endnote Web . e

3dman_eu- CC0O

* Wichtig: zuerst eine Sicherungskopie Ihrer Endnote Library erstellen (Meni
file -> compress library, dort Optionen with file attachements und all
references in library auswahlen -> next -> Speicherort wahlen

* Regqistrieren Sie sich mit Ihrer email-Adresse und legen sich ein Konto an
« Sie haben Zugriff auf eine umfangreiche Online-Anleitung

« Mit EndnoteWeb kann man an jedem Rechner Referenzen importieren und
anschliel3end in die Desktop-Version tdbernehmen

« EndnoteWeb ermdglicht die Arbeit im Team

« Uber den Button sync in der Endnote-Datenbank konnen die Referenzen
Online und in der Desktop-Version synchronisiert werden

« Schauen Sie sich ein Webinar zum Thema Synchronisieren an
 PDF's und Custom Groups werden mit synchronisiert
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https://access.clarivate.com/login?app=endnote
http://www.screencast.com/t/rcZqvBvuZqJ
https://pixabay.com/de/laptop-lernen-schule-computer-1019763/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Noch Fragen? 1NFO

3dman_eu- CCO

« Tools und Techniken zum Wissenschaftlichen Arbeiten finden Sie auf der
Homepage der SUB

« Beratung zum Schreiben gibt es beim Schreiblabor der Universitat

« Auf Youtube gibt es eine umfangreiche Sammlung von Video-Tutorials zum
Thema Recherchestrategien und Literatursuche

 |nformationen zur guten wissenschaftlichen Praxis finden Sie auf den Seiten
der Uni Goéttingen

« Die Uni Gottingen hat Informationen zum Thema Plagiate
zusammengestellt

 die UMG hat Richtlinien flr die aufdere Form der Dissertation verfasst
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https://www.sub.uni-goettingen.de/lernen-lehren/wissenschaftlich-arbeiten-tools-und-techniken/
https://www.uni-goettingen.de/de/individuelle+schreibberatung/578710.html
https://www.youtube.com/@LOTSE-ULBMS
https://www.uni-goettingen.de/de/604506.html
https://www.uni-goettingen.de/de/566172.html
https://www.umg.eu/studium-lehre/promotion/informationen-fuer-promovendinnen/verfahrensablauf/verschriftlichung-der-arbeit/
https://pixabay.com/de/users/3dman_eu-1553824/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Wir sind online immer fir Sie da:
Bereichsbibliothek Medizin (BBM)

 Alle Angebote fur Medizinstudierende auf einen Blick

« Auf der SUB-Homepage finden Sie unsere online-Angebote
thematisch sortiert

« Bei Bedarf individuelle Termine nach Absprache (Kontakt:
dhaerter@sub.uni-goettingen.de oder Tel.: 39-19527)
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https://www.sub.uni-goettingen.de/standorte-raumangebote/standorte-mit-oeffnungszeiten/bereichsbibliothek-medizin/
https://pad.gwdg.de/MediBib-info?view
https://www.sub.uni-goettingen.de/-cJTgW
mailto:dhaerter@sub.uni-goettingen.de
https://pixabay.com/de/banner-header-fragezeichen-frage-1090830/
https://creativecommons.org/publicdomain/zero/1.0/deed.de

Q U q NIEDERSACHSISCHE STAATS- UND
-~ L UNIVERSITATSBIBLIOTHEK GOTTINGEN

Viel Erfolg bei Ihren Projekten!
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SUB Gottingen

Sofern einzelne Inhalte nicht anders angegeben sind,
Ist dieser Selbstlernkurs unter einer CC BY 4.0 Lizenz
veroffentlicht.

https://creativecommons.org/licenses/by/4.0/
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